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ВСТУП 

 

Методичні вказівки  призначені для виконання графічних робіт та 

самостійної роботи  з дисципліни «САПР в будівництві» студентами 

спеціальності 192 – Будівництво та цивільна інженерія в редакторі тривимірної 

графіки  SketchUp. 

Предметом САПР є розробка методів побудови та читання креслень, 

методів геометричного моделювання.  

Дана методична розробка призначена для формування системи знань з 

фундаментальної графічної підготовки студентів з орієнтуванням на фаховий 

профіль; навчання основним прийомам роботи при створенні тривимірних 

моделей будівель, меблів, інтер’єрів, пейзажів, анімації, сцени з реалістичним 

світлом і тінями. Програмний продукт SketchUp дозволяє імпорт файлів з 

інших програм або інструментів 3D-моделювання та експорт файлів SketchUp 

для використання з іншим програмним забезпеченням для моделювання та 

редагування зображень. 

Методичні вказівки спрямовані на допомогу в оволодінні системою знань і 

вмінь, спрямованих на створення й опрацювання тривимірних зображень, 

вивчення реально існуючих та об’єктів, що проектуються, за їх зображеннями; 

розвиток геометричної логіки та просторової уяви, здатності мислити 

просторовими образами.  
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1 ЗАПУСК ПРОГРАМИ. ВИБІР ШАБЛОНУ НАЛАШТУВАНЬ  

1.1 Інтерфейс програми 

Для запуску програми необхідно клікнути на ярлику програми, що 

знаходиться на робочому столі, або вибрати через стандартну процедуру 

Windows: «Пуск»> «Усі програми»> «SketchUp» (рисунок 1.1). Відразу після 

завантаження програми бачимо робочий простір SketchUp і в його центрі - 

відкрите Вікно-запрошення (Welcome to SketchUp). Для реєстрації ліцензії 

після придбання (перехід в Pro версію) відкриваємо закладку License> Add 

License і вводимо свої дані. Через це ж вікно доступні також Learn - довідкові 

та навчальні інтернет-ресурси (англійською мовою) і деякі інші, але зараз 

розглянемо тільки розділ Template (Шаблони). Це набір попередньо 

встановлених налаштувань проекту, з яких потрібно вибрати найбільш 

підходящий варіант для виконання  завдань. Template - закладка Template 

Selection (Вибір шаблону), в якій призначається для поточного сеансу роботи (і 

запам'ятовується для подальших) потрібний варіант. Доступні одиниці як 

метричні, так і в футах і дюймах. Обираємо те, що потрібно - наприклад, 

міліметри. 

 

Рисунок 1.1 – Запуск SketchUp 

File, Edit, View - типова система панелі Menu bar (Панелі головних 

текстових меню). Під нею знаходяться Toolbars (Панелі інструментів) з 

кнопками (buttons) швидкого виклику найбільш затребуваних команд, які в 

своїй більшості дублюють аналогічні пункти меню (і навпаки). 

Відкриваємо меню View> Toolbars (Вид> Панелі інструментів) і ставимо 

галочку на Standard (Стандартні), (рисунок 1.2). Кнопки цієї панелі активують 

опції: New (Новий), Open (Відкрити), Save (Зберегти), Cut (Вирізати), Copy 

(Копіювати), Paste (Вставити), Undo (Скасувати), Redo (Повторити), Print 

(Друкувати) , Model info (Інфо по моделі). В нижній частині екрану бачимо 

Status bar (Панель стану, статусний рядок), на яку в кожен момент часу 

виводиться вся необхідна поточна інформація. Основну площу робочого вікна 

програми займає Вікно моделювання - сцена, на якій все і відбувається. 

 

Рисунок 1.2 – Панель інструментів Standart 
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Панелі інструментів SketchUp наведені на рисунку 1.3. 

 

Рисунок 1.3 – Панелі інструментів SketchUp 

Унизу екрану бачимо Status bar (Панель стану), на яку в кожен момент 

часу виводиться вся поточна інформація. Основну площу робочого вікна 

програми займає Вікно моделювання - сцена, на якій відбуваються побудови. 

У SketchUp відсутнє традиційне літерне позначення осей, вони мають  

колірне кодування. Вісь X представлена суцільною (додатні значення) і 

точковою (від’ємні значення) (red) червоною лінією. Аналогічно, вісь: Y - 

зеленою (green), Z - синьою (blue) лініями. Площина, на якій перетинаються 

червона і зелена вісь (X і Y), утворює (ground plane) - «землю», а величини по 

осі Z визначають «підйом або спуск» щодо рівня «землі». 

Розмістимо курсор на саму ліву кнопку в панелі і затримаємося на ній - 

через дуже коротку паузу «спливає» текстова підказка (Tooltips) (рисунок 1.4) 

під назвою інструмента - Select (Вибір) і в Панелі статусу з'являється ще одна, 

яка пропонує обрати об'єкт для роботи з ним іншими інструментами або 

командами: 

 

Рисунок 1.4 – Текстова підказка Tooltips 

В Панелі статусу з'явилася підказка щодо можливих дій з цим 

інструментом - перша пропонує вибрати об'єкт в сцені, інші говорять про два 
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інших способи вибору. Аналогічну реакцію інтерфейсу будемо постійно бачити 

при роботі з усіма кнопками (інструментами). 

Ще один дуже зручний механізм інтерфейсу SketchUp - контекстні меню, 

які викликаються кліком на елементах (об'єктах) побудов. В основному ці меню 

дублюють пункти текстових меню і кнопки інструментів і забезпечують 

швидкий і зручний доступ до потрібних опцій. Головний принцип їх роботи - 

зміст контекстних меню змінюється в залежності від конкретного контексту і 

показує всі опції, можливі саме з ним (обраним об'єктом) на даний момент 

(рисунок 1.5). 

 

Рисунок 1.5 – Контекстні меню 

 

1.2 Базові інструменти 

Відкриваємо меню View> Toolbars (Вид> Панелі інструментів), 

відключаємо (знімаємо «галочку») у пункті Getting Started (панель зникає) і 

включаємо показ (ставимо галочки) на Principal (Основні) і Drawing 

(Малювання) - панелі цих груп інструментів самі встають на призначені для 

них місця в вертикальну колонку. 
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Основні (Principal) інструменти:  Select (Вибір);  Component 

(Компонент);  Гумка (Ластик);  Paint Bucket (Палітра).  

Інструменти малювання (drawing):  Line (Лінія);  Arc (Дуга); 

 Freehand (Від руки);  Rectangle (Прямокутник);  Circle (Коло); 

 Багатокутник (Polygon). 

1.3 Навігація в сцені 

Всі інструменти навігації доступні з головного текстового меню Camera,  

раціональніше працювати з кнопками на панелі інструментів, і ще більш зручно 

- через можливість тимчасового перемикання на функції камери з будь-якого 

іншого інструменту без виходу з нього, використовуючи тільки кнопки миші. 

Розглянемо групу інструментів - управління «ручною» камерою, тобто такою, 

якою можна вільно маніпулювати, використовуючи мишку.  

Відкриваємо меню View> Toolbars, включаємо показ (ставимо галочку) на 

пункті Camera (Камера) - блок кнопок додається в панель інструментів. При 

роботі з камерою об'єкти завжди залишаються на своїх місцях! А «фізично» 

об'єкти в просторі сцени можуть переміщатися тільки відповідними 

спеціальними інструментами модифікацій. 

Інструмент обертання камери Orbit  навколо Target - точки 

націлювання погляду (про це трохи далі). При цьому ми як би «об'їжджаємо з 

камерою в руках» на фіксованій відстані від цієї точки, постійно утримуючи 

погляд на ній. За замовчуванням камера утримується у вертикальному (щодо 

«землі») положенні, але при необхідності, натиснувши клавішу Ctrl вісь камери 

можна відхилити на будь-який кут, тобто нахилити її щодо лінії горизонту. 

Якщо обертати камеру, одночасно натиснувши та утримуючи клавішу Shift, 

тимчасово перемикаємось в інший інструмент - панорамування Pan . 

Інструмент переміщення камери в площині екрану на фіксованій відстані «в 

глибину» - тільки ліворуч, праворуч, вгору, вниз. Неважко помітити, що це 

повний аналог такого ж інструменту 2D-редакторів, що зрозуміло, оскільки тут 

доступна маніпуляція камерою тільки в одній площині, тобто в двох вимірах. 

Інструмент збільшення (при русі курсору вгору по екрану) або 

зменшення (рух курсора вниз по екрану) зображення об'єкту - тобто 

наближення/видалення. Важливий момент, який слід запам'ятати - точка 
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націлювання погляду за замовчуванням визначається позицією курсору в сцені 

в даний момент. Працює і ще один дуже простий і зручний механізм 

«примусової цілевказівки» - зробивши подвійний клік будь-яким з цих трьох 

інструментів камери в будь-який потрібній точці вікна моделювання, тим 

самим однозначно націлюємо камеру (погляд) саме на неї. Візуально це 

виглядає як виведення зображення «цілі» в центр екрану. 

Zoom Window  (Вікно збільшення) - інструмент показу кордонів 

вікна перегляду (збільшення) «розтягується» прямокутником вибору. Також як 

і Pan, фактично повний аналог такого ж інструменту 2D графічних редакторів.  

Інструмент виведення вікна перегляду такої міри збільшення / зменшення 

зображення, в якому показуються (охоплюються) всі об'єкти сцени одночасно: 

Zoom Extents (Показати все) . Дуже корисний в ситуаціях, коли потрібно 

відновити втрачену орієнтацію в сцені після будь-яких випадкових або 

невдалих маніпуляцій з камерою або після імпорту дуже великих об'єктів.   

Група інструментів навігації, панель яких викликаємо через головне 

меню View> Toolbars> Views (Види) по порядку: Iso (Ізометрія); Top (Зверху); 

Front (Спереду); Right (Праворуч); Back (Ззаду); Left (Зліва). Крім того, є ще 

вид Bottom (Знизу), який не представлений кнопкою на панелі інструментів (як 

досить рідко використовується) і доступний тільки з головного меню Camera> 

Standard Views (Стандартні види), (рисунок 1.6). 

 

Рисунок 1.6 – Види (Views) 

За замовчуванням після запуску програми) ми працюємо в вікні Iso 

(Ізометрія). Зі стандартними видами пов'язаний ще один додатковий механізм 

огляду (тільки з меню Camera) - вибір режиму погляду між Parallel Projections 

(Паралельним), в якому всі лінії уздовж кожної з осей паралельні (тобто в 

ортогональних проекціях) або Perspective (Перспективним), з перспективними 

спотвореннями (він і включений за замовчуванням). 

В меню Camera бачимо ще один специфічний, також умовний варіант 

проекції - Two-Point Perspective (Двоточкова перспектива), яка відрізняється 

тим, що всі вертикалі побудов паралельні синій осі і між собою, а перспектива 

працює тільки для горизонтальних напрямків. Наслідком такого механізму є те, 

що з інструментів «ручний» камери працюють тільки Pan і Zoom. При спробі 

обертання камери інструментом Orbit відбувається автоматичний вихід з цього 

режиму в перспективну проекцію. На практиці Двоточкова перспектива 

традиційно застосовується в конструкторському і архітектурному проектуванні 
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- наприклад, може виявитися найбільш зручною і наочною для показу інтер'єру 

приміщення. 

1.4 Порядок роботи 

1. Ознайомитись з засобами для конструювання, малювання, модифікації 

та уявлення панелі ToolBars. 

2. Активувати інструмент Line Tool  і накреслити лінію та замкнений 

контур з необхідною кількістю вершин (згідно варіанту). 

3.  Збережіть файл, змінивши назву Untitled шляхом File->Save As... на 

необхідну. В назві файлу повинно бути прізвище та номер виконаної роботи 

(Петренко_1). 

4. В рядку стану (Status Bar), який відображає повідомлення та підказки 

знайти Value Control Box для відображення точних значень. 

5. Перемкнути вид зверху (Top View) на ізометрію (Isometric) за 

допомогою панелі стандартних інструментів Standard Views Tool Bar. 

6. Активувати інструмент Лінія (Line). Якщо ви не бачите осей проекції, 

виберіть View / Axes або натисніть Alt + X. Щоб відрегулювати налаштування 

лінії, відкрийте вікно Preferences (Window/Preferences). Виберіть розділ 

Drawing. Click-drag-release використовує мишу для побудови лінії. Click-move-

click будує лінію між двома точками. Auto detect активує автовизначення 

способу використання мишки. Якщо ви хочете використовувати обидва ці 

методу, виберіть Auto detect. 

7. Відкрийте вікно Model info, вибравши в меню Window / Model info  та 

розділ Colors і подивіться колір, яким будуть відображатися ребра (Edges). 

Змініть чорний колір за замовчуванням на синій.  

8. Виконавши вище вказані вимоги, намалювати плоский контур 

(спряження) згідно варіанту. 

1.5 Завдання для самостійної роботи 

Використовуючи комбінації клавіш Click-drag-release, Click-move-click, 

Auto detect виконати найпростіші геометричні побудови та пояснити їх 

відмінності при використанні різних комбінацій клавіш. 

1.6 Питання для самоконтролю 

1. В чому різниця застосування налаштувань: Click-drag-release, Click-

move-click, Auto detect? 

2. Які кольорові позначення мають осі Х, Y та Z? 

3. Чи дозволяє інструмент Line проводити лінії, які в подальшому стануть 

ребрами [edges] об'єкту? 
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1.7 Висновки 

Звіт (скрін побудованого плоского контуру/спряження згідно варіанту) 

підвантажити  в MOODLE до контрольної дати.  

При захисті роботи виконати побудови за вказівкою викладача.  

Контрольні питання 

1. Яким чином відображаються точні значення в SketchUp? 

2. Коли лінія (або інший об'єкт типу арки, кола, полігону) формує 

замкнутий контур, чи формується всередині нього площина? 

3. Як згенерувати грань [face] в SketchUp?  

4. Які засоби дозволяють створити площину в SketchUp? 

5. Як налаштувати властивості лінії в SketchUp? 

6. Які модифікації з поверхнями дозволяє виконувати SketchUp? 

7. Як дотримуватись паралельності та перпендикулярності між об’єктами 

при виконанні побудов в SketchUp? 

8. Чи дозволяє SketchUp створити поверхню, три точки якої (або три 

замкнених ребра) не належать одній площині? 

9. Як розділити цілісну поверхню на будь-яке число окремих частин-

поверхонь? 

10. Чому дуга є першим типовим представником «псевдокривих» 

SketchUp? 
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2 ІНСТРУМЕНТИ ТА ОПЦІЇ МОДИФІКАЦІЙ 

2.1 Теоретичні відомості 

Інструменти (рисунок 2.1) використовуються для модифікацій (змін, 

спотворень, редагування) об'єктів. У тому числі і перетворення вже створених 

інструментами малювання плоских 2D-фігур в 3D-моделі, а також для змін 

положення (позицій), розмірів, пропорцій будь-яких існуючих об'єктів і їх 

окремих елементів меню View> Toolbars, ставимо галочку на пункті 

Modification (Модифікації) - блок їх кнопок додається в панель інструментів.  

 

Рисунок 2.1 – Інструменти модифікацій 

 Push / Pull (Втиснути / Витягнути). Даний інструмент не працює з 

ребрами, а тільки з Faces (поверхні) і - тільки в напрямку, перпендикулярному 

до вихідної поверхні. За один раз можна застосувати інструмент тільки до 

однієї, одиничної поверхні, тобто він «не вміє» одночасно працювати з 

декількома (зібраними множинним вибором) поверхнями, що навіть лежать в 

одній площині. Є два варіанти послідовності дій:  

Спосіб 1. Якщо нічого в сцені не вибрано, то після розміщення курсору 

інструменту (який зміниться на його зображення) на поверхню автоматично 

відбувається її вибір, немає необхідності її попереднього вибору інструментом 

Select, немає необхідності попередньо клікати на поверхні, що витягується, - 

досить просто переміщати курсор Push / Pull з натиснутою кнопкою мишки і 

поверхня буде «слідувати» за ним. Для завершення опції відпускаємо кнопку 

миші в потрібний момент (при досягненні потрібної величини). 

Спосіб 2. Обираємо потрібну поверхню, натискаємо кнопку інструменту. У 

курсору з'являється синя точка, що говорить про те, що тепер курсором можна 

клікати в будь-якому місці (на цьому або іншому об'єкті в сцені), вказуючи 

спочатку початкову точку (точку відліку), потім кінцеву, завершуючи опцію. 

При цьому між цими двома кліками можна як завгодно змінювати ракурс 

камери - інструмент «пам'ятає» обрану для опції поверхню. 

 Follow Me (Слідуй за мною) – видавлювання площини 2D-фігури 

(профілю), уздовж певної направляючої лінії. Профілем видавлювання може 

бути будь-яка поверхня (Face), а направляючої (Path) - будь-яка одиночна лінія-

ребро (пряма або ламана) або ребро іншої поверхні. 

Рисунок 

1.3 
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Особливість дії інструменту - після початку опції профіль автоматично 

«прилаштовується» до початкової точки направляючої лінії, розвертаючись 

таким чином, що її початковий сегмент стає нормаллю до профілю. 

Інструментом можна створити більш складний об'єкт, вибравши в якості 

направляючої не одну, а дві суміжні поверхні (в т.ч. що лежать в різних 

площинах) або навіть кілька - така можливість залежить від конкретної 

геометрії. SketchUp має рішення застосуванням Follow Me за рахунок 

використання кругової напрямної, необов'язкове примикання профілю до 

напрямної окружності, а характер результуючого об’єму буде залежати від 

взаємного розташування і розмірів профілю і напрямного кола.  

 Offset (Контур) – інструмент не створює нові тривимірні об'єкти,  

полегшує завдання додавання деталей в модель і створення об'єктів зі 

складними об’ємами. Принцип дії - створити копію в одній площині ребер 

поверхонь будь-яких обрисів (а також окремих кривих) за рахунок їх 

копіювання на однаковій відстані від початкового положення елементів - як 

всередину, так і назовні. Під «кривими» розуміється два і більше суміжних 

прямих лінійних сегмента, що лежать в одній площині - по 3D-термінології - 

coplanar. Для окремих кривих необхідний попередній вибір всіх її сегментів 

інструментом Select. У випадку з поверхнями, оскільки створюються нові 

ребра, завжди створюється і нова (додаткова) поверхню, яку вони обмежують. 

 МOVE (переміщення) використовується для переміщення об'єктів і 

елементів побудов. Тут працюють ті ж два способи (послідовності) виконання 

опції вибору об'єкта впливу, аналогічні інструменту Push/Pull - без 

попереднього вибору, якщо нічого не вибрано до цього, і з попередньою 

вказівкою об'єкта його вибором. Натиснувши клавішу Ctrl переміщується не 

елемент, а його копія, а оригінал залишається на місці. 

 Rotate (обертання) – це інструмент обертання об'єктів «повністю» 

або їх спотворення за рахунок обертання окремих елементів побудов. Після 

вибору інструменту стандартний курсор змінюється на зображення інструменту 

Protractor (Транспортир) з круговими стрілками. Зауважимо, що робота 

Protractor, як і інших інструментів модифікацій, контролюється точними 

числовими вимірами, точніше - кутовими величинами. Можливі два варіанти 

роботи інструменту: перший - коли курсор (а також площина і центр 

обертання) виходять за межі об'єкта, в порожньому просторі сцени. Другий 

варіант - центр обертання повинен знаходитися на самому об'єкті. При цьому 

курсор автоматично прагне «лягти» на одну з поверхонь об'єкту під ним - якщо 

її орієнтація збігається з одним з планів осей, курсор «забарвиться» в цей колір. 

У всіх інших випадках - залишиться чорного кольору, показуючи тим самим, 

що площина обертання не збігається ні з одним з планів осей. 
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Якщо центр обертання повинен перебувати поза об'єктом, потрібно 

попередньо вибирати об'єкт (елемент об'єкту) інструментом Select (вказуючи, 

що саме його будемо обертати), а вже потім включати і настроювати 

інструмент Rotate. Попередній вибір буде потрібен і при призначенні повороту 

декількох об'єктів одночасно. Ctrl = toggle Copy - якщо вибрати інструмент, і 

перед, або під час обертання клікнути клавішу Ctrl (утримувати не обов'язково), 

то обертатися буде не сам об'єкт, а його копія (оригінал залишається на місці). 

Як бачимо, це аналог опції дублювання з переміщенням інструменту Move, 

тільки дублювання відбувається по коловій траєкторії. 

 Scale (масштабування). Інструмент використовується для зміни 

розмірів і пропорцій об'єктів цілком і їх окремих елементів для спотворення. 

Для вказівки об'єкту майбутнього масштабування можливі два варіанти вибору 

(як і для інших раніше розглянутих інструментів модифікацій): можна чи 

попередньо вибрати його інструментом Select, а потім вибрати (включити) 

інструмент кліком на кнопці (стандартний курсор змінюється на зображення 

інструменту), або спочатку включити інструмент, а потім клікнути його 

курсором на об'єкті (елементі). Працює тільки і завжди за напрямками осей 

сцени. На прикладі кубика, «правильно» орієнтованого по осях, тобто такого, в 

якому кожна з граней (поверхонь) паралельна одному з планів осей, а ребра, 

відповідно, паралельні осях виберемо для масштабування одну з граней, 

наприклад - верхню, тобто фактично розглянемо роботу інструменту на плоскій 

формі. З'являється габарит межі з жовтих ліній з зеленими кубиками - grip 

(зажимами) в кутах і в серединах ребер - всього 8 шт. на поверхню. Кожна пара 

затискачів «відповідає» за можливий напрямок масштабування в одну і іншу 

сторону. У цьому «плоскому» прикладі, зрозуміло, будуть задіяні тільки дві осі 

- зелена і червона (рисунок 2.2). 

 

Рисунок 2.2 – Приклади масштабування 

Підказки в рядку статусу: «Ctrl = About Center» - натиснувши клавішу Ctrl 

відбувається масштування в обидві сторони по лінії, що з'єднує затискачі від 

центру обраного елемента; «Shift = Toggle Uniform» - перемикач поперемінного 

натискання клавішею Shift пропорційного / не пропорційного масштабування 

по задіяним осях. Крім того, якщо одночасно будемо утримувати Ctrl + Shift, 
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отримаємо масштабування від центру - за кутові «затиски» - непропорційне, за 

всі інші - пропорційне. 

2.2 Побудова поверхонь  

Faces/Surfaces (Плоскі/ Криволінійні поверхні). На практиці доведеться 

зіткнутися із завданням побудови поверхонь складної кривизни, наприклад - 

рельєфом місцевості. 

Soften / smooth Edges (згладжування ребер) – оптимальним є підхід, при 

якому використовується мінімально необхідна деталізація моделей в поєднанні 

з ефектом пом'якшення/згладжування спеціальної опцією, яка відкривається з 

меню Window> Soften Edges або, що аналогічно - з контекстного меню 

(рисунок 2.3). 

 

 

Рисунок 2.3 – Згладжування ребер 

 

Angle Between Normals (Кут між нормалями) - величина кута між 

суміжними поверхнями, при перевищенні якої «ребро-кордон» між ними буде 

візуально пом'якшене або згладжене. Зі збільшенням значення кута 

(переміщення движка праворуч) буде відбуватися більше спотворення моделі. 

Крайнє ліве положення движка означає повне відключення згладжування. Така 

можливість іноді потрібна для тимчасового наочного показу геометрії 

поверхонь складної кривизни, оскільки деякі інструменти включають 

згладжування автоматично. Результат також залежить від поєднання 

параметрів, які призначаються перемикачами нижче слайдера: Smooth Normals 

(Згладжування нормалей) - включення цієї опції «згладжує» ребра між 

суміжними поверхнями, так, що вони разом починають сприйматися 

програмою як єдина, цілісна криволінійна поверхня.  

Soften Coplanar (Пом'якшення Coplanar поверхонь) - включення цієї опції 

«пом'якшує» ребра між суміжними, що лежать в одній площині поверхнями, до 

їх повного приховування (аналогічно опції Hide). 

Пом'якшення/згладжування ребер - чисто зоровий ефект представлення 

моделі, який не впливає на її геометрію - щоб переконатися в цьому, зробіть 

потрійний клік на згладженому об'єкті (вибір всіх елементів), що дасть 

можливість побачити в т.ч. його приховані опцією ребра. 
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2.3 Порядок роботи 

1. Побудувати плоску поверхню у відповідності до ескізу згідно варіанту, 

виданого викладачем. При побудові використовувати інструмент face. 

2. За допомогою інструмента Push / Pull отримати тривимірні об’єкти 

двома способами:  

- автоматично курсором вибрати початкову поверхню та переміщуючи 

курсор Push / Pull з натиснутою кнопкою миші отримати рух/утворення нової 

поверхні на вказану в завданні відстань; 

- вибрати потрібну поверхню, натиснути кнопку інструменту, клік в будь-

якому місці (на цьому або іншому об'єкті в сцені), вказуючи спочатку 

початкову точку (точку відліку), потім кінцеву, завершуючи опцію. При цьому 

між цими двома кліками можна як завгодно змінювати ракурс камери - 

інструмент «пам'ятає» обрану для опції поверхню. 

3. Виконати видавлювання площини 2D-фігури (профілю згідно варіанту)  

вздовж певної напрямної лінії (Path) - будь-яка одиночна лінія-ребро (пряма або 

ламана) або ребро іншої поверхні за власним бажанням. 

4. Створити об’ємне тіло обертання за допомогою Follow Me. 

2.4 Завдання для самостійної роботи 

Побудувати поверхню складної кривизни (рельєф місцевості) згідно 

варіанту, запропонованого викладачем. При створенні звіту додати скрін 

отриманого рельєфу до відповідного розділу в MOODLE.  

2.5 Питання для самоконтролю 

1. На що впливає використання Soften/smooth Edges при конструюванні 

поверхонь? 

2. Чи впливає згладжування ребер на геометрію моделі? 

3. На що впливає величина кута між суміжними поверхнями Angle 

Between Normals? 

2.6 Висновки 

Звіт (скріпи п’яти побудованих поверхонь) завантажити  в MOODLE до 

контрольної дати.  

При захисті роботи виконати побудови за вказівкою викладача.  

2.7 Контрольні питання 

1. Які інструменти модифікації наявні в SketchUp? 

2. Які обмеження в роботі інструменту Push / Pull? 

3. Чи можливе створення нового тривимірного об’єкту за допомогою 

інструменту Offset? 

4. Як змінити розміри або пропорції об'єкту та його окремих елементів? 

5. Чи можливе використання інструменту Offset (Контур) для роботи з 

Arc (дугами), і з кривими, намальованими інструментом Freehand? 
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3  ПРАКТИЧНІ ПОБУДОВИ 

3.1 Початок роботи 

Запустити SketchUp в налаштуваннях шаблону. Програма підтримує будь-

які розміри сцени без обмежень, тому працюємо в реальних величинах. Всі нові 

побудови починати, «прив'язуючись» до центру сцени - так буде зручніше 

повертатися в початковий вигляд з будь-якого іншого ракурсу камери одним 

кліком на кнопках панелі інструментів Views (Види). 

Інструментом Rectangle рисуємо прямокутник цоколя будинку від центру 

сцени, «зачепившись» за нього першим кутом і розтягуючи по «землі» до 

другого протилежного кута на відповідну величину (рисунок 3.1). 

 

Рисунок 3.1 – Побудова основи цоколю будинку 

Після збереження файлу почне працювати опція автозбереження, що 

допоможе не втратити виконану роботу в разі непередбачених проблем.  

Другим кроком «піднімаємо» інструментом Push/Pull (Штовхати / 

Тягнути) поверхню прямокутника основи на потрібну висоту - отримуємо об’єм 

цоколя будинку (рисунок 3.2). 

 

Рисунок 3.2 – Отримання об’ємної моделі 
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Завдання створення «фізично повноцінного» об'єкту вирішує 

найважливіша опція SketchUp - Make Group (Створити групу). Група являє 

собою пов'язану в єдине ціле комбінацію будь-яких (в т.ч. по розташуванню в 

сцені) елементів побудов, які з моменту угрупування сприймаються програмою 

як один об'єкт. Група створюється вибором потрібних елементів (об'єктів) та 

застосуванням команди меню Edit> Make Group або аналогічної - з 

контекстного меню. Зворотня опція (розрив групи) доступна з меню Edit> 

Group> Explode або з аналогічного пункту контекстного меню раніше створеної 

групи.  

Відміна від простого набору окремих елементів і головна перевага групи 

полягає в тому, що з моменту угрупування не тільки «народжується» єдиний 

об'єкт, але він ще й «фізично» відділяється від інших елементів моделі. 

Набагато простіше (особливо в складній сцені), працювати з групами-

об'єктами, ніж з розрізненими ребрами і поверхнями - починаючи з опцій 

вибору і закінчуючи будь-якими іншими діями з ними.  

Всі опції модифікацій будуть впливати на групу, як єдине ціле, тобто на 

все що містять її об'єкти одночасно і з однаковими параметрами. Наочна 

ілюстрація - групи мають дуже зручну функцію «розвороту на місці», точніше - 

навколо геометричного центру групи (рисунок 3.3). Це робиться за допомогою 

інструменту Move. Активуємо інструмент і поміщуємо його курсор на одну з 

поверхонь габариту об'єкта (сині лінії) - з'являється зображення Protractor 

(транспортир), а фактично - інструмент обертання Move і чотири червоних 

хрестика - маркера, за які можна повернути групу в цій площині. Площини 

габаритного боксу завжди паралельні планам осей сцени, незалежно від об'єктів 

його вмісту і орієнтації в сцені. 

 

Рисунок 3.3 – Робота з групою 

3.2 Додаткові механізми вибору 

Вибір у швидкій послідовності:  

- одиничний клік - обирається одиночний елемент під курсором; 
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 - подвійний клік (неважливо, на поверхні або на будь-якому з її ребер) - 

одночасний вибір і цієї поверхні, і всіх її ребер; 

 - потрійний клік (на будь-якому елементі побудови) - одночасний вибір 

всіх суміжних елементів, що належать одному окремому побудові (об'єкту). 

Вибір і створення групи через контекстне меню: 

Відкриємо контекстне меню, зробивши клік правою кнопкою миші на 

будь-якому ребрі або поверхні ще не згрупованого «цоколя» - і далі, через 

пункт Select> All Connected (Все пов'язане) отримуємо той же необхідний 

результат вибору всіх його елементів (рисунок 3.4). Після завершення опції 

контекстне вікно закривається - тут же викликаємо його знову і вибираємо 

пункт Make Group.  

 

Рисунок 3.4 – Створення групи через контекстне меню 

Використання контекстного меню дає можливість буквально в пару кліків 

мишкою отримати той же результат без «багатокрокових» переходів по 

пунктам основних меню або кнопок панелей інструментів. 

Lock (Фіксація) групи 

Після створення групи в контекстному меню з'являється цей, 

притаманний тільки групам (і компонентам) пункт. Сенс його очевидний - до 

застосування зворотньої команди Unlock (Зняття фіксації), об'єкт «закритий, 

захищений» від усіх видів вибору і редагування, що позначається зміною 

кольору ліній його габариту на червоний. 

Entity Info (Інформація по елементу) – це підказка - що у нас вибрано, і 

які має характерні параметри (рисунок 3.5). Тут можна призначити і змінити 

параметри і атрибути, доступні для редагування в даній конкретній ситуації. 

Таким чином, це фактично додатковий інформаційно-керуючий інструмент, 

надзвичайно корисний у практиці моделювання. 
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Рисунок 3.5 – Інформація по елементу 

3.3 Побудова стін  

Спосіб 1. Малюємо по верхній площині цоколя прямокутник того ж 

розміру, фактично повторюючи його контури - ребра прямокутника будуть 

зовнішньою межею стін. Пам'ятаємо, що завдяки згрупованому об'єкту - 

цоколю під ним, зараз починаємо створення нового, незалежного об'єкту. Далі 

інструментом Offset рухом всередину позначаємо внутрішню межу стін і 

видаляємо внутрішню поверхню - залишається поверхня, що утворює товщину 

стіни. А тепер плоску основу стін інструментом Push/Pull витягуємо, 

піднімаємо на потрібну висоту (рисунок 3.6). 

 

Рисунок 3.6 – Перший спосіб побудови стін 

Спосіб 2. Після рисування поверхні прямокутника - зовнішнього габариту 

стін, відразу витягуємо з нього об’єм інструментом Push/Pull на потрібну 

висоту. Потім, як і в 1-м способі, інструментом Offset рухом всередину 

позначаємо внутрішню межу стін (рисунок 3.7).  

 

Рисунок 3.7 – Другий спосіб побудови стін 



21 

 

Push/Pull «продавлюємо» внутрішню поверхню вниз, до рівня верху 

цоколя (підлоги приміщення). Причому зовсім необов'язково бачити, 

«виловлювати» при русі цей момент - тут можна використовувати для 

контролю точності чудовий механізм snapping - прив'язки до контрольних 

точок і ребер побудов (рисунок 3.8). 

 

Рисунок 3.8 – Завершення побудови стін 

3.4 Віконні та дверні прорізи 

 Малюємо по зовнішній поверхні стіни інструментом Rectangle 

прямокутник дверного отвору, і потім інструментом Push / Pull продавлюємо 

його до внутрішньої поверхні стіни, підказуючи переміщенням курсору на її 

ребро величину (глибину). По завершенню опції відпустивши кнопку миші, 

поверхня продавлювання зникає (рисунок 3.9) і утворюється наскрізний отвір. 

Це типовий випадок отримання наскрізних отворів (прорізів). 

 

Рисунок 3.9 – Отримання віконних та дверних прорізів 

Використовуючи можливості опції дублювання з переміщенням (Move + 

Ctrl), отримуємо необхідну кількість копій прорізів, та уважно стежимо за 

напрямком переміщення - строго по осі (площини) стіни. Потрійним кліком  

вибираємо всі елементи побудови стін> Make Group - створюємо групу стін 

(даємо ім'я групі, наприклад, «stіnи»). 



22 

 

3.5 Побудова даху 

Етапи побудови даху (один з можливих варіантів) представлені на 

рисунку 3.10: 

 

Рисунок 3.10 – Етапи побудови даху 

По завершенню побудови створюємо групу «Дах». 

3.6 Редагування всередині групи 

SketchUp надає зручний механізм «внутрішнього» редагування груп, який 

фактично є «зворотним ходом» множинного вибору швидкими кліками 

інструментом Select:  

- першим одиночним кліком вибираємо групу;  

- подвійним кліком «входимо всередину групи». При цьому бачимо, що 

з'являється її тривимірний габарит, позначений точковими лініями, а все, що 

знаходиться поза групою - «затінюється». Тобто тим самим позначається 

доступна для редагування зона дій і відповідно все, що знаходиться за нею -  

заблоковано. І це дуже зручно - можна застосовувати будь-які інструменти і 

опції без побоювання «пошкодити» інше, що знаходиться поза групою 

 - третім поодиноким кліком вибираємо потрібний елемент і працюємо з 

ним. 

Потрійний клік одразу надає доступ до редагування елементу. 
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Ще про дин варіант швидкого входу в редагування групи - контекстна 

команда Edit Group. При цьому потрапляємо в стан, аналогічний подвійному 

кліку на групі, а далі вибираємо і редагуємо потрібний елемент групи. Для 

виходу з режиму «внутрішнього редагування» натискаємо в будь-якому місці 

сцени зовні - отримуємо «стару» групу з новим змістом. 

До складу групи можуть входити будь-які елементи і об'єкти побудов - в 

т.ч. інші групи, в складі яких можуть бути інші елементи, об'єкти, групи і так 

далі. Крім використання пунктів меню, можна  застосовувати стандартні для 

Windows: копіювання в буфер - Ctrl + С, вирізання - Ctrl + X; вставка з буфера - 

Ctrl + V (потрібно вказати місце вставки в сцену вмісту буфера завершальним 

кліком). Уточнювати положення вставленого об'єкту - переміщувати його в 

потрібне місце. 

 

3.7 Порядок роботи 

1. Інструментом Rectangle накреслити прямокутник цоколя від центру 

сцени, «зачепившись» за нього першим кутом і розтягуючи по «землі» до 

другого протилежного кута на відповідну величину. 

2. Інструментом Push / Pull (Штовхати / Тягнути) підняти поверхню 

прямокутника основи на потрібну висоту.  

3. За допомогою Make Group створити групу для виконання стін будинку. 

4. Інструментом Rectangle виконати віконні та дверні прорізи. 

5. Побудувати прямокутник стелі. 

6. Розширити стелю на ширину карнизу інструментом Offset та підняти на 

необхідну висоту. 

7. Орієнтуючись на підказку «midpoint», розділити поверхню на дві 

частини. 

8. Підняти коньок даху по синій осі Move + Alt. 

 

3.8 Завдання для самостійної роботи 

Побудувати другий та мансардний поверх котеджу на основі заданого 

плану 1-го поверху. Форму даху обрати за власним бажанням.  

3.9 Питання для самоконтролю 

1. Як оптимально виконати побудову другого та мансардного поверхів за 

наявності першого? 

2. Як виконати вальмовий дах? 
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3.10 Висновки 

Зіт з 5-6 скрінів та файл моделі в оригінальному форматі завантажити в 

MOODLE до контрольної дати. 

При захисті роботи виконати побудови, вказані викладачем. 

3.11 Контрольні питання 

1. Як створити групу з необхідних елементів? 

2. Як виконати побудову цоколю будинку? 

3. Як створити групу через контекстне меню? 

4. Якими способами можна виконати редагування в групі в SketchUp? 

5. Що означає Lock – фіксація групи? 

6. Які характерні параметри зашифровані в інформації по елементу Entity 

Info? 

7. Назвіть два можливі способи побудови стін? 

8. Як створити віконний проріз? 

9. Як створити копії вікон (дверей) за допомогою дублювання з 

переміщеням (Move + Ctrl)? 

10. Як вирізати групу з поточного становища та вставити точно на те ж 

місце в іншу групу, використовувати опцію меню Edit> Paste in Place? 
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4  ВИМІРИ. ТОЧНІСТЬ ПОБУДОВ.  

КОНСТРУКЦІЙНІ ЕЛЕМЕНТИ 

4.1 Теоретичні відомості 

В панелі Measurements реалізовані одночасно дві функції - контролю і 

управління. Динамічно, в реальному часі в панелі «коментуються» дії 

поточного інструменту в числових значеннях так, що в будь-який момент після 

досягнення потрібної величини ми можемо їх завершити. В зворотному 

порядку - можемо безпосередньо управляти самими інструментами, 

призначаючи точні необхідні числові значення дії опцій. Наприклад, почавши 

малювання лінії, бачимо її поточну довжину, і тут же можемо ввести інше, 

потрібне, точне значення. Для довідки - є можливість зробити панель 

інструменту «плаваючою» (вивести з статусного рядка) і розмістити її в будь-

якому місці вікна моделювання, як і будь-яке інше діалогове вікно - для цього 

включаємо пункт Measurements в меню View> Tools (рисунок 4.1). 

 

Рисунок 4.1 – Панель вимірів 

Загальні принципи використання панелі:  

1. Активуємо інструмент, Measurements виводить найменування та 

поточні числові значення працюючої опції. 

 2. Якщо необхідно призначити свої числові значення, набираємо їх на 

клавіатурі під час (до завершення) або відразу після завершення налаштування 

(до початку іншої опції), і натискаємо Enter для підтвердження.  

Поширена помилка початківців - не потрібно поміщати курсор в панель, 

не потрібно намагатися клікати в панелі перед набором значення на клавіатурі 

(та це й неможливо) - введення з клавіатури зчитується в панель автоматично і 

спрацьовує після підтвердження натисненням Enter. Якщо по ходу набору (до 

натискання Enter) вирішили замінити значення на інше - покроково 

«витираємо» цифри клавішею Backspace. 

3. Формат введення і показу числових значень залежить, перш за все, від 

налаштувань одиниць вимірювань, встановлених для проекту. Повний набір 

налаштувань проекту (файлу) призначається в діалоговому вікні Window> 

Model Info> Units (Про нього докладно - далі). Іноді у користувача виникає 

проблема - Measurements просто не спрацьовує при введенні чисел в форматах, 

показаних в цій книзі. Швидше за все, джерело проблеми - в налаштуваннях 

Windows - тут наведено стандартні формати MS Windows, які призначаються в 

Панелі управління> Мова і регіональні стандарти> Регіональні параметри> 

Налаштування> Числа. Тут у віконці «Роздільник цілої та дробової частини» 
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повинна стояти кома (,), а у віконці «Роздільник елементів списку» - крапка з 

комою (;).  

4. Якщо в панелі одночасно виводяться дистанції (розміри, координати) 

по декількох осях сцени, завжди передбачається стандартна послідовність 

(порядок) слідування осей: по червоній (X) - по зеленій (Y) - по синій (Z).  

5. Усі літерні символи, використовувані в панелі, повинні бути на 

латиниці (перемикається на «англійську» розкладку клавіатури). 

6. Введення від’ємних величин (зі знаком «мінус») вказує програмі, що їх 

треба відраховувати в напрямку, протилежному початкового напрямку руху 

курсору.  

7. Будь-який інструмент при його повторному використанні завжди 

прагне використовувати (повторити) попередню введену в Measurements 

величину (величину дії) - не поспішаємо, уважно стежимо за поведінкою 

курсору і числовими значеннями, що з'являються в панелі. 

4.2 Одиниці виміру 

Model Info / Units  

Панель Model Info/Units  (рисунок 4.2) використовується для призначення 

за замовчуванням лінійних і кутових одиниць виміру і налаштування точності 

роботи використовують їх інструментів в поточному проекті. 

 

Рисунок 4.2 – Панель Model Info / Units 

Length Units (Одиниці довжини):  

- Format (Формат) - в списку обираємо потрібний -  Decimal (Десятковий), 

інші використовують тільки фути і дюйми. У списку вибираємо конкретно: 

міліметри, сантиметри або метри.  
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- Precision (Точність) - точність обраної одиниці вимірювань (кількості 

нулів після коми). Наприклад, для будівельних конструкцій краще призначити 

як мінімум - з точністю «до десятих», тобто «0,0».  

- Enable length snapping (Використовувати лінійне збільшення) - 

мінімально можливий крок збільшення величин при малюванні або 

модифікуванні. Призначивши цю величину = «1,0» вже не зможемо 

намалювати мишкою лінію довжиною менше 1 мм. Це ж обмеження буде діяти, 

наприклад, і при переміщенні об'єкта інструментом Move. Можна встановити 

інші одиниці виміру і підвищити точність їх відображення - це питання 

особистих переваг. Треба тільки мати на увазі, що в подальшому саме ці 

параметри будуть використані у всіх вимірювальних опціях, і найголовніше - в 

механізмі контролю числових значень панелі Measurements.  

- Display units format (Показувати формат одиниць) - Вкл. / Викл. показу 

позначень одиниць вимірювання поруч з числовими значеннями в панелі 

Measurements і при нанесенні розмірів на об'єктах. 

- Force Display of 0 "(Встановлення нуля) - опція використовується для 

показу 0" дюймів в «західній» архітектурній системі одиниць (в десятковій 

системі недоступна).  

Angle Units (Кутові одиниці): 

 - Precision (Точність) - установка точності відображення градусів в 

десяткових одиницях (кількість нулів після коми). 

 - Enable angle snapping (Використовувати кутовий приріст) - призначення 

кроку збільшень кутів при використанні інструментів Protractor (Транспортир) і 

Rotate (Обертання). У віконце поруч вводимо потрібне значення (за 

замовчуванням 15,0 град). Цей параметр при повільному, акуратному обертанні 

буде проявлятися як відчутні «зарубки» на круговій шкалі. 

4.3 Керування інструментами малювання 

  Line (Лінія): маємо напрямок (орієнтацію) лінії і приблизну 

довжину - вводимо на клавіатурі точне необхідне значення, натискаємо Enter. 

Це найпоширеніший варіант призначення довжини лінії від стартової до 

кінцевої точки. Можливий також більш трудомісткий, але іноді необхідний в 

якихось ситуаціях введення параметрів лінії в координатах осьової системи 

сцени: - відносних (за 0 приймається стартова точка малювання лінії) - 

вводяться координати кінцевої точки в форматі: Length: <500; 300; 200> - 

абсолютних (від 0 основних осей сцени) в форматі: Length: [500; 300; 200]. 

Зрозуміло, що тут порядок чисел відповідає стандартному порядку 

проходження осей: по червоній - по зеленій - по синій. 
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З інших пунктів контекстного меню Лінії зупинимося на двох останніх. 

Divide (Поділ) - цілісна лінія може бути розділена на будь-яку кількість рівних 

сегментів (рисунок 4.3). 

 

Рисунок 4.3 – Налаштування лінії 

Zoom Extents доступний для всіх елементів побудов, завдання його - 

миттєве збільшення зображення обраного елемента на весь екран. 

 Arc (Дуга) 

 Lenght (Довжина) - цю величину безпосередньо змінити не можна, так як 

вона залежить від радіуса і кількості сегментів, і буде змінюватися з їх зміною. 

 З інших пунктів контекстного меню:  

Divide (Поділ) - поділ дуги на будь-яку кількість рівних сегментів в 

«плоских» 2D-побудовах, в т.ч. коли дуга стає і ребром поверхні. У складі 

геометрії 3D-об'єкта опція недоступна.  

Explode Curve (Розірвати Криву) - розриває дугу на прості пов'язані 

сегменти з можливістю редагування кожного сегмента. Дуга після цього буде 

виглядати так ж, але не може більше редагуватися, як елемент Дуга.  

Convert to Polygon (Конвертувати в Багатокутник) - створює з згладженої 

дуги незгладжені криву. 

 Rectangle (Прямокутник), (рисунок 4.4) 

 

Рисунок 4.4 – Витягування прямокутника 
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 Circle (Коло): 

 Divide (Поділ) - поділ кола на будь-яку кількість рівних сегментів в 2D-

колі. У складі геометрії 3D-об'єкта опція недоступна. Працює аналогічно цієї ж 

опції в Line і Arc.  

Explode Curve (Розірвати Криву) - розриває коло на прості пов'язані 

сегменти з можливістю редагування кожного сегмента. Після цього буде 

виглядати так само, але не може більше редагуватися, як елемент Circle.  

Convert to Polygon (Конвертувати в Багатокутник) - створює зі згладженої 

окружності незгладжену криву.  

 Polygon (Багатокутник) 

 Scale (Масштабування) 

Числові значення (коефіцієнти) масштабування і напрямок (вісь або осі), 

динамічно відображаються в Measurements, і можна в будь-який момент 

замінити їх на свої введенням потрібних значень. Введення значення = 2, 

означає, що по зеленій осі буде виконано дворазове збільшення розміру моделі. 

І зрозуміло, що коефіцієнт = 1 означає, що ніякого збільшення не буде, тобто 

модель залишиться в початковому стані. В залежності від місця розміщення 

обраних «затискачів» (на ребрі, на поверхні) в поєднанні з клавішами Ctrl, Shift, 

Ctrl + Shif можливі різні варіанти масштабування - у напрямку від однієї до 

трьох осей одночасно.  

Для ознайомлення з групою Конструкційних елементів переходимо до 

меню View> Toolbars, включаємо показ (ставимо галочку) на пункті Constrution 

(Конструкційні) - блок їх кнопок додається в основну панель інструментів. 

 Tape Measure (Рулетка) - з його допомогою вимірюються лінійні 

відстані між будь-якими двома точками в просторі сцени. Рулетка працює в 

будь-яких напрямках, але частіше за все, що зрозуміло, застосовується або в 

площинах планів осей, або «веде відлік» від ліній осей і ребер об'єктів. Якщо 

починаємо «витягування стрічки» рулетки від кінцевої точки лінії, ребра (або 

точки початку осей - origin), то по завершенні опції створюється Guide Point 

(Опорна точка, точка розмітки); якщо починаємо від будь-якої іншої 

(проміжної) точки на лінії, ребрі (або на будь-який осі) - Guide Line (Опорна 

лінія, лінія розмітки) нескінченної довжини.  

Для побудови Guide Line включаємо інструмент (курсор змінюється на 

його зображення із позначкою «+»)> натискаємо на стартовій точці> 
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переміщаємо курсор в напрямку вимірювання - витягується лінія зі стрілками 

на кінцях кольору осі, вздовж якої відбувається переміщення, і чорна 

пунктирна нескінченна лінія Guide> в кінцевій точці натискаємо вдруге. У 

підсумку в сцені залишається лінія розмітки для подальшого використання з 

будь-якими іншими інструментами (рисунок 4.5).  

    

Рисунок 4.5 – Побудова Guide Line (ліворуч) та Guide Point (праворуч) 

Створення Guide Point - аналогічно, тільки замість нескінченної лінії 

отримуємо пунктирну лінію від початку до кінця вимірювання з точкою-

хрестиком на кінці. 

Ці розміточні елементи забезпечують високу точність побудов за рахунок 

ефекту «прив'язки» до них інших елементів побудов, а тому з їх допомогою 

зручніше (а іноді це і єдина можливість) точно виконати елемент або зробити 

модифікації ребер і поверхонь, замість того, щоб намагатися «виловлювати» 

мишкою потрібну відстань або точку. 

 Protractor (Транспортир) 

Транспортир може розміщуватися на планах осей (і «вести відлік» від 

осей), або на поверхнях об'єктів, приймаючи відповідну площину орієнтації.  

Можна зафіксувати цю орієнтацію, натиснувши і утримуючи клавішу Shift, що 

дає можливість перемістити Транспортир в інше місце в тому ж положенні.  

Для побудови Guide після вибору інструмента:  

1. Розміщуємо курсор в потрібне місце і першим кліком показуємо точку 

центру обертання - вершину вимірюваного кута.  

2. Обертаючи рулетку, натискаємо вдруге для визначення положення 

першої лінії розмітки (одного боку кута) на осі, поверхні або ребрі об'єкта.  

3. Обертаючи рулетку, натискаємо втретє для визначення положення 

другої лінії розмітки (другої сторони кута) в потрібній фінальній точці, яка 

залишається в сцені, як опорна лінія.  
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Axes (Осі) Призначення інструменту - переміщення або 

переорієнтації основних осей сцени.  

Потреба в такій опції може виникнути при роботі з елементами, 

малювання або модифікації яких повинні відбуватися під кутом до напрямів 

основних осей, і найзручніше це зробити, просто змінивши орієнтацію осей під 

конкретну ситуацію. 

Порядок побудови моделі в розмірах: 

1. Масштабування сцени, виходячи з того, що є один з розмірів, про який 

точно відомо, що він правильний. 

Приймаємо за «справжню» величину, наприклад, висоту дверного прорізу 

= 2000мм. Заміряємо Рулеткою (з включенням Ctrl) ребро прямокутника 

отвору, замість отриманої величини вводимо необхідні 2000, і підтверджуємо 

запит на зміну розміру (масштабу) моделі.  

2. Перевіряємо та коригуємо розміри сходів. 

3. Коригуємо, за необхідності, висоту цоколя, стін та інше. 

4. Опускаємо дах в нове положення - до нового рівня верху стін. 

4.4 Порядок роботи  

1. Активувати інструмент Measurements. 

2. Ввести власні числові параметри згідно варіанту та завершити 

виконання Enter. Якщо в панелі одночасно виводяться дистанції (розміри, 

координати) по декількох осях сцени, завжди передбачається стандартна 

послідовність проходження осей: по червоній (X) - по зеленій (Y) - по синій (Z). 

3. Виконати налаштування точності (Precision) кутових одиниць та 

кутового прирощення (Enable angle snapping). 

4. Виконати побудову моделі в розмірах згідно варіанту. 

4.5 Завдання для самостійної роботи 

Виконати налаштування одиниць довжини Length Units: Format 

(Формат) – Precision (Точність) - Enable length snapping (лінійне 

прирощення) - Display units format (Відображати формат одиниць). 

Змінивши висоту стін в моделі виконати побудову даху для іншої висоти 

будівлі. 

4.6 Питання для самоконтролю 

1. Що означає введення від’ємних величин інструмент Measurements? 
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2. Які одиниці довжини наявні в SketchUp? 

4.7 Висновки 

Звіт у вигляді чотирьох скрінів, які відображають налаштування одиниць 

довжини, завантажити в MOODLE до контрольної дати. 

4.8 Контрольні питання 

1. Що означає інструмент Force Display of 0
//
? Чи доступний даний 

інструмент в десятковій системі? 

2. Які кутові одиниці Angle Units наявні в SketchUp? 

3. Від чого залежить формат введення і показу числових значень? 

4. Яке діалогове вікно відповідає за повний набір налаштувань проекту 

(файлу)? 

5. Яка стандартна послідовність слідування осей при одночасному 

введенні в панелі дистанції (розмірів, координат) по декількох осях сцени? 

6. Як призначити за замовчуванням лінійні і кутові одиниці виміру і 

налаштування точності роботи для використання їх інструментів в поточному 

проекті? 

7. Які формати (Format) одиниць довжини можливі в SketchUp? 

8. Як задати мінімально можливий крок збільшення величин при 

малюванні або модифікуванні? 

9. Як зробити панель інструменту за необхідності «плаваючою» (вивести 

з статусного рядка)? 

10. Як побудувати Guide Line та Guide Point? 

11. Як перемістити або переорієнтувати основні осі сцени при 

необхідності? 

12.Як виконується масштабування сцени? 

13. Як виміряти лінійні відстані між будь-якими двома точками в 

просторі сцени? 

14. Як виконати масштабування вздовж однієї необхідної осі? 
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5  РОБОЧА ВІЗУАЛІЗАЦІЯ. МАТЕРІАЛИ. ШАРИ  

5.1 Налаштування відеокарти 

Відкриємо меню Window> Preferences (Основне налаштування). Вікно 

використовується для призначення основних постійних налаштувань програми, 

які будуть задіяні в поточному сеансі та у всіх проектах (файлах) при 

подальшому відкритті (до їх зміни на інші). У діалозі Preferences звернемося 

тільки до одного пункту – OpenGL - бачимо «пульт управління» відеокартою 

(рисунок 5.1).  

 

Рисунок 5.1 – Налаштування відео карти 

OpenGL Setting: - Use Hardware Acceleration (Використання апаратного 

прискорення) - включивши цей пункт, ми отримуємо апаратну підтримку цієї 

програмної функції за рахунок підключення обчислювальних ресурсів 

відеокарти. SketchUp буде працювати набагато швидше і з максимально 

якісним рендерингом, тому цей пункт повинен бути постійно включений. 

- Use maximum texture size (Використання максимального розміру 

текстури) - можливість відображення текстур (растрових іміджів) в матеріалах, 

призначених на об'єктах, з розмірами без обмежень. При «слабкій» відеокарті 

такі текстури можуть відображатися з дефектами, про що з'являється 

попередження. 

- Use Fast Feedback (Використовувати швидкий зворотний зв'язок) - 

параметр, що прискорює перемальовування на екрані. Варто тримати постійно 

включеним. 
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5.2 Інструменти приховування 

В будь-який момент будь-які вибрані елементи можуть бути швидко 

приховані опцією Hide (Приховати), яка швидше і зручніше за все активується з 

контекстного меню. Це ж можна зробити з пункту меню Edit> Hide, а також 

Вкл. / Викл. перемикача Hidden (Прихований) в діалоговому вікні обраного 

елементу (об'єкту) Entity Info (рисунок 5.2).  

 

Рисунок 5.2 – Інструменти приховування hide / unhide 

Щоб знову відобразити раніше приховані об'єкти, відкриваємо пункт 

меню Edit> Unhide (Скасувати приховування), і далі обираємо по одному із 

зручних в даній ситуації варіантв: Selected (Вибране), Last (Останній), All (Все). 

Є ще один спосіб приховування, який працює тільки з ребрами - включивши 

інструмент Eraser (Ластик), бачимо в статусному рядку підказку: Shift = Hide. 

Тобто працюємо Ластиком так, як і для «стирання» ребер, але, утримуючи 

клавішу Shift його функція змінюється - відбувається не видалення ребер, а їх 

приховування. У деяких ситуаціях цей механізм дуже зручний для вибіркового 

приховування окремих ребер. 

Якщо в ході роботи потрібно «вибірково» скасувати приховування для 

будь-яких окремих елементів (об'єктів) - передбачена спеціальна опція 

«умовного» показу всіх побудов, прихованих раніше опцією Hide. 

Використовуємо пункт меню View> Hidden Geometry (Вид> Прихована 

геометрія) - приховані побудови будуть показані («проявляться») в сцені в 

«пунктирно-сітковому» вигляді. Після цього потрібне легко вибрати, зробити 

видимим опцією Unhide, і знову вимкнути показ прихованої геометрії. 

5.3 Відображення поверхонь і ребер 

Стилі поверхонь відкриваємо за допомогою меню View> Toolbars> 

Styles (або View> Face Style) - блок кнопок Стилів стає на призначене для нього 

місце у верхній панелі інструментів (рисунок 5.3).  
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Рисунок 5.3 – Меню стилів 

 Shaded with Textures (Затінений з текстурами) - максимально 

можлива реалістичність рендерингу в SketchUp, яку можна отримати під 

графічним 3D-движком OpenGL. Відображаються всі матеріали поверхонь 

(кольору і текстури), а також освітлення (тіні). 

 Hidden Line (Лінійний) – варіація на тему попереднього стилю в 

манері чорно-білої ілюстрації з відображенням тіней. Найчастіше 

застосовується не на стадії робочого моделювання, а при стилізації фінальної 

подачі проекту. 

 Monochrome (Безбарвний) – модель відображається тільки в двох 

кольорах проекту «за замовчуванням», що показують ситуацію з Face / 

Backface. 

  X-Ray (Рентген) – працює в парі з будь-яким з чотирьох раніше 

описаних стилів, додаючи до них ефект «просвічування рентгеном» або 

«напівпрозорості». 

 Wireframe (Каркас) – відображаються тільки ребра поверхонь (не 

приховані до цього опцією Hide), і оскільки самих поверхонь не бачимо, ніякі 

інструменти, що працюють з ними, не застосовуються (тіні і матеріали в т.ч.). У 

той же час отримуємо повний доступ до всіх ребрах побудов, незалежно від 

ракурсу камери. 

5.4 Тіні 

Меню View> Toolbars> Shadows - блок кнопок інструментів Тіней стає на 

своє місце у верхній панелі інструментів (рисунок 5.4).  

 

Рисунок 5.4 – Інструменти Тіней 
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Light, Dark (Світло, Темрява) - слайдери, вони фактично регулюють 

контрастність тіней на освітлених і затінених частинах сцени за рахунок зміни 

співвідношення цих параметрів (рисунок 5.5). 

 

Рисунок 5.5 – Параметри тіней 

Кнопка в верхньому лівому кутку - загальний вимикач тіней Show / Hide 

Shadows. Віконце правіше пов'язано з геолокацією, тобто прив'язкою моделі до 

реального географічного розташування. Слайдерами нижче - Time і Date 

призначаємо час року, місяць і дату. 

Тіні в SketchUp створюються двох типів: власні (затінення поверхонь 

об'єктів) і падаючі (від об'єктів на землі і на поверхнях сусідніх об'єктів). А 

оскільки обчислювальне навантаження на візуалізацію від тіней дуже значне, 

передбачений механізм їх роздільного включення / вимикання. 

Під матеріалами в SketchUp розуміють як «забарвлення» поверхонь в 

однотонні кольори, так і нанесення на них текстур. Текстурами в 3D-

моделюванні прийнято називати растрові іміджі (зазвичай - фотореалістичні), 

процес нанесення яких можна представити як «обтяжку», «заливку» або 

«обклеювання» поверхонь такими іміджами замість однотонної забарвлення. 

 Paint Bucket (Палітра) працює з функціональними клавішами - без 

попереднього вибору поверхні забарвлення:  

+ Ctrl («Відерце» курсору доповниться трьома горизонтальними 

квадратиками) - при кліці на фарбується в цей же колір забарвиться і все 

послідовно суміжні поверхні об'єкту. 
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+ Shift  («Відерце» курсору доповниться трьома квадратиками куточком) 

- при кліці на фарбується в цей же колір забарвиться абсолютно всі об'єкти 

сцени. 

+ Shift + Ctrl («Відерце» курсору доповниться трьома вертикальними 

квадратиками) - при кліці на фарбується в цей же колір забарвиться тільки все 

«фізично» пов'язані елементи побудов (пов'язаної геометрії). 

+ Alt  («Відерце» курсору тимчасово перетворюється в «піпетку») - взяття 

зразка матеріалу з будь-якої пофарбованої (або текстурованою) поверхні - 

утримуючи Alt, натискаємо в потрібному місці (беремо зразок), відпускаємо Alt 

- «заповнюється» цим матеріалом. 

Діалогове вікно Materials (Матеріали): Window > Materials (Матеріали) 

відкриває два основні розділи - вкладки Select (Вибір) і Edit (Редагування) 

(рисунок 5.6). 

 

Рисунок 5.6 – Діалогове вікно Матеріали 

Color (Колір) – список, що розкривається Picker (Вибір) містить кілька 

варіантів колірних моделей представлення кольору, що застосовуються в 

комп'ютерній графіці. Першим в списку знаходиться Color Wheel (Кольорове 

колесо), на якому представлений весь спектр доступних кольорів. Потрібний 

колірний тон вибирається переміщенням квадратика - «прицілу», а його 

«чистота» регулюється вертикальним слайдером за рахунок зміни частки 

чорного кольору.  

Точні числові параметри визначення кольору: 

- HLS (Hue, Light, Saturation) - призначає колір за трьома параметрами: H 

- колірний тон (власне «чистий» колір в спектрі), S - насиченість кольору 

(частка чорного в кольорі), L - світлота (частка білого в кольорі) .  

- HSB (Hue, Saturation, Brightness) - практично аналогічна попередній, 

відрізняється тільки використанням поняття яскравості (B) замість світлоти (L).  

- RGB (Red, Green, Blue) - модель «моніторних» квітів, де R - частка 

червоного, G - частка зеленого, B - частка синього кольору. Колір в цих трьох 



38 

 

моделях визначається положенням движків слайдерів, або введенням числових 

значень. 

Texture (Текстура) - це панель управління опціями заміни (аналогічно 

заміні кольорів) поточної «забарвлення» на текстурний матеріал, або заміни 

поточної текстури на іншу, після чого вона з'являється в списку In Model 

закладки Select. Крім того, тут є кілька простих опцій редагування параметрів 

текстури (рисунок 5.7). 

 

Рисунок 5.7 – Використання текстур 

Opacity (Непрозорість) – опція використовується для призначення 

непрозорості матеріалу (числове значення - у відсотках). Пересуванням 

слайдера ліворуч/праворуч або введенням числа в віконце значень від 0 (повна 

прозорість) до 100 (повна непрозорість), (рисунок 5.8). 

 

Рисуно5.8 – Вікно опції «Непрозорість» 

 Create Material (Створити матеріал) - створення нового матеріалу 

на основі поточного активного (рисунок 5.9), редагується не саме поточний 

активний матеріал, а його незалежна копія, яка після натискання кнопки ОК 

з'являється в списку In Model як нового додаткового матеріалу. 
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Рисунок 5.9 – Створення нових матеріалів 

Будь-яке редагування засобами Materials діє одночасно і однаково на всі 

поверхні всіх об'єктів сцени, де цей матеріал був застосований.  

Результат дії Шарів - розподіл по ним об'єктів з можливістю їх показу/ 

приховування за рахунок включення/вимикання видимості самих шарів. 

Об'єкти, «розташовані» в різних шарах SketchUp, не ізолюються, а самі шари 

працюють тільки в частині приховування/показу об'єктів, що «належать» їм. 

Відкривається діалогове вікно через меню Window> layers (рисунок 5.10).  

 

Рисунок 5.10 – Діалогове вікно Шарів 
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Будь-який з створених шарів (крім Layer 0) можна видалити кліком на 

круглій кнопці зі знаком «-». При цьому з'являється запит про вибір 

«перепризначення» елементів, що належать цьому шару, на інший шар:  

Move contents to Default Layer - перемістити вміст на шар за 

замовчуванням (тобто на Layer 0);  

Move contents to Current Layer - перемістити вміст на активний шар. Це, 

фактично, можливість об'єднання вмісту двох шарів.  

Delete contents - видалити вміст шару назавжди. При видаленні активного 

шару (будь-якого, крім Layer 0) другий варіант, зрозуміло, буде недоступний. 

Можна в цій же колонці впорядкувати шари (крім Layer 0) за їхніми іменами в 

прямому і зворотному алфавітному порядку, клікаючи на заголовках колонок.  

При необхідності видалення декількох шарів одночасно можна 

використовувати стандартні опції множинного вибору з клавішами Ctrl і Shift. 

5.5 Порядок роботи  

1. Відкрити меню View > Toolbars > Shadows. 

2. Вимкнути параметр Use sun for shading (Використовувати сонце для 

затінення) - перемикач, що активує можливість використання і зміни 

налаштувань власних (лицьових) тіней поверхонь при вимкненому показі тіней 

в сцені - тобто без тіней падаючих. 

3. Увімкнути Use sun for shading. 

4. Увімкнути Show/Hide Shadows. 

5. Вибрати інструмент Materials (курсор Paint Bucket змінюється на 

символ «відерця») та відкрити діалогове вікно Materials (Матеріали). 

6. Призначити матеріал, натиснути «ковшиком» на об'єкт - пофарбувати 

його, «заливаючи» всю обрану поверхню в її межах-ребрах. 

7. Виконати поетапну візуалізацію будинку від цоколя до даху. 

5.6 Завдання для самостійної роботи 

1. Виконати налаштування тіней для сцени, базуючись на реальному 

географічному положенні моделі та тимчасових (дата, день, година) 

параметрах. 

5.7 Питання для самоконтролю 

1. Які інструменти приховування hide / unhide наявні в SketchUp? 

2. Як відрегулювати контрастність тіней на освітлених і затінених 

частинах сцени? 



41 

 

5.8 Висновки 

Звіт у вигляді 5-6 скрінів виконаної візуалізації двоповерхового котеджу 

завантажити в MOODLE до контрольної дати. 

При захисті роботи виконати побудови, вказані викладачем. 

5.9 Контрольні питання 

1. Як вибірково скасувати приховування для будь-яких окремих 

елементів, об'єктів? 

2. Які стилі поверхонь наявні в SketchUp? 

3. Які стилі відображення ребер наявні в SketchUp? 

3. Чи можливе достовірне відображення тіней в закритих об'ємах, 

наприклад, в інтер'єрах приміщення в SketchUp? 

4.  Як вмикається показ падаючих тіней в SketchUp? 

5. Як відбувається налаштування власних та падаючих тіней в SketchUp? 

6. Які стилі рендерингу в SketchUp дозволяють побачити призначені 

матеріали? 

7. Як виконати забарвленням згладжених криволінійних поверхонь 

(Surfaces) в SketchUp? 

8. Як одночасно виконати фарбування кількох поверхонь? 

9. Як створити новий матеріал на основі існуючого? 

10. Як отримати доступ до візуалізації в сторонній програмі з 

поверненням об’єкту в SketchUp в оновленому вигляді? 

11. Які особливості кольорових моделей з точними числовими 

параметрами визначення кольору  HLS (Hue, Light, Saturation), HSB (Hue, 

Saturation, Brightness  та RGB (Red, Green, Blue)? 

12. Як призначити ступінь непрозорості матеріалу в SketchUp? 

13. Як створити унікальну текстуру з використанням опції Make Unique 

Texture на поверхні будь-якої форми? 

14. Як призначити фототекстуру в SketchUp? 

15. Яке призначення та результат дії шарів в SketchUp? 

16. Які основні вимоги до створення шарів в SketchUp? 
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